
 

 
       

 

       

    

         

         

   

 

 
 

GIS I:  Organizing Principles 
Displaying  Spatial Data Exercise  

*** Files needed for exercise: RI_poverty_Rate_2017, RI_Hospitals_FQHCs_201912 in 
ExerciseData.gdb 

Goals: The goal of this exercise is to create a map with both qualitative and quantitative data of the 

poverty rate in the state of Rhode Island. 

Skills: After completing this exercise, you will be able to make a flat map with ArcGIS Pro given 

project data. You will be familiar with adding data to ArcGIS Pro, symbolizing attributes, and creating 

a PDF map. 

Creating a  ArcGIS Pro  Project  
1.  In the Windows  Explorer  Start  Menu,  type ArcGIS  Pro in the search and  open  ArcGIS Pro.  

2.  Click  on  New  >  Blank Templates >  Map.  In the popup,  name your  map project  and 

specify  your  saving  location  to your  drive and then click  OK.  
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Adding Data  and Connecting to Folders  
1.  On the top ribbon,  switch to  View  tab and click  on Catalog  View.  

2.  You are now  in the catalog view.  Right  click  on the Folders  in the Contents  pane  on the right  

hand side,  and select  Add Folder Connection.  

3.  Navigate  to  this  module’s  exercise folder,  SINGLE CLICK  on the  3_Displaying_Spatial_Data  and 

click  OK.  You  now  have a connection to  that  folder  in this  project  making it  quicker  to find and 

add  data.  
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4.  Click  on the Map  view  tab  to switch to the map you were working  on before.  

5.  On the top ribbon,  Click  on Map and then  Add  Data  icon to add new  data to the  map.  

6.  Click  Folders  on the right  hand side and browse to 3_Displaying_Spatial_Data > 

ExerciseData.gdb.   

7.  From  the folder,  click  the shapefile RI_poverty_Rate_2017.  This  file  contains  tract-level  data 

for  the poverty  rate  American Community  Survey  (ACS)  2017.  
8.  Once you’ve selected the file,  click  OK  and the data will  appear  in the Contents  as  a  layer.  

9. Click the Add Data icon again and from the same database, select the file 

RI_Hospitals_FQHCs_201912. This is a file containing point data for CMS Approved hospitals 

and Federally Qualified Health Centers (FQHCs) in Rhode Island and 5 miles around. This 

dataset extract is from the Quality Improvement Evaluation System (QIES) database which is 

serviced by Health Resources & Services Administration (HRSA). It includes information 

about provider number, name, and address and characterizes the participating institutional 

provider. Click OK. Both layers should now appear in the Contents. 
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Working with Qualitative D ata  
1.  Take a look  at  the current  symbolization of  the census  tracts  of  Rhode Island  and  all C MS  

approved hospitals a nd  FQHCs.  The  tracts  are  displayed with one color  corresponding to  the   

symbol  in the  Table of   Contents.  The hospitals  and FQHCs ar e also  displayed with one  color   

corresponding to one symbol.  Colors  may   var y  from  the exampl e below.  

2. You can try to click and hold on RI_poverty_Rate_2017, then drag the layer up and down to 

rearrange the layer. Would the layer order affect the display? 

3. View the RI_Hospitals_FQHCs_201912 layer’s attribute table to see what data it contains. 

Right click the RI_Hospitals_FQHCs_201912 in the Contents and select Attribute Table. 

4. A new pane will appear with the attributes of RI_Hospitals_FQHCs_201912. Look at the fields. 

The table has the address and other information about the CMS approved hospitals and 

FQHCs. Which fields appear qualitative? The fields that differentiate Facility Category: Hospital 

or FQHC are qualitative. Close the attribute table by clicking the ‘x’ in the top right corner of the 

tab. 
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5. Now you will change the symbolization of the facilities approved by CMS. Right click the 

RI_Hospitals_FQHCs_201912 layer in the Contents, select Symbology. 

6. The Symbology pane should appear on the right. 

7. You will display your qualitative data by categories. Under Primary symbology, select Unique 
values. In the Field 1 drop-down menu, choose the field Facility Category. After a few seconds, 

all classes in the facilities file will be added into the window below. 
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8. Single click on the colored dots to change the symbols for different type of facilities. Let’s first 

change the size of the points to 3 pt. Then pick your favorite color. 

9. Then, click on the Layers icon to switch to detail configuration tab and set the Outline width to 

0 pt. Please remember, nothing changes unless you hit Apply on the bottom. 

10. Click on the back button on the top of this pane to go back to the primary symbology page. 

Similarly, change the symbol for Hospitals. 

11. Examine the map with your new symbols. Are the symbols an appropriate size and shape? Are 

colors easily distinguished? If not, return to the Symbology pane and adjust the size, shape or 

color. Remember, you have to click Apply to save your changes. 

12. You may want to change your tracts layer to a neutral color so the health care centers are 

more visible. Do this by single clicking on the color swatch for the tracts layer in the Content 
and adjusting the color. 

13. You now have a map of Rhode Island CMS approved facilities symbolized by their 

categories. This could be very useful information. 

6



 
GIS I:  Organizing Principles 
Displaying  Spatial Data Exercise  
 

  
         

          

  

 
          

         
   

 
           

       

 
  

Adding a N ew  Map  
1.  Next,  you’ll  work  on a second map with poverty  rate  data.  From  the  Insert  tab on  the top ribbon,  

select  New  Map  to add a new  map  to your  project.   

2. Rename the new map “Poverty rate” by clicking on the “Map1” and then clicking again (slow 

double click). Next, click on the Map tab to go back to your previous map and rename it “CMS 

approved facilities”. 

3. Right click to Copy the RI_poverty_Rate_2017 layer from the CMS approved facilities map. 

Click on the Poverty rate tab switch to the new map. Right click on Poverty rate in the 

Contents; select Paste. 

4. Go back to Map tab, slowly double left click on Map under Contents pane to change it to CMS 

Approved facilities. Now both of your maps have names. 
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Working with Quantitative D ata  
1.  View  the RI_poverty_Rate_2017  layer’s  attribute table in Poverty  rate  map  to see what  data it  

contains.  Right  click  the layer  in the Contents  and select  Attribute  Table.  

2.  A  new  pane  will  appear  with the attributes  of  RI_poverty_Rate_2017.  The pctBelow  field  is  the 

percentage  of  population that  below  poverty  line in 2017.  Close the  table.  

3.  You  will s ymbolize  tracts  by  poverty  rate.  Right  click  the RI_poverty_Rate_2017  layer  in 

the Contents,  select  Symbology.  

4.  Modify  the selections  to show  quantities  using a color  gradation.  In the Primary  symbology  
dropdown list,  select  Graduated colors.  Under  Field,  select  pctBelow.  

5.  To change the classification  method,  click the  dropdown list  and pick  .  Method Quantile

6. The class break point will be displayed on the bottom half of the pane. If you click on the 

Histogram, you will see how data distributed in those 5 categories. 

7. Switch back to Classes tab instead of Histogram, change the Color scheme to the color of 

your choice. For legibility, it is best practice to use a monochromatic (single hue) color ramp for 

data that is increasing or decreasing invalue. 
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8. Change the Label format. Click on the Advanced symbol options button on the very top and 

then expand Format labels. There are many different format categories depending on what 

type of data you are displaying. Change the number of decimal places to 1. 

9. You may notice that in the Rhode Island census tract file, we have a few census tracts that are 

water tracts, and there is no population living in those census tracts. Keeping those census 

tracts in the file will affect the classification method. We will need to exclude them for better 

classification by using the ALAND field in the layer RI_poverty_Rate_2017. On the same panel, 

expand the Data exclusion tab. 

10. Click on + New expression to add a new expression to define the shapes that you wanted to 

exclude. 

11. In the combo box that appears below, select the drop down lists to make the sentence – Where 

ALAND is equal to 0. This means we are going to exclude all census tracts with 0 land area. 

Then click Apply. 
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12. Now all your symbols and labels setting should be done. Your Contents pane should look like 

the screenshot displayed below. 

13. Single click on the swatch for <excluded> to change the color to Water (area). Then your map 

will looks like this. 

14. Right click on RI_poverty_Rate_2017, go back to Symbology. Change the Method from 

Quantile to any other category, then change back to Quantile. You will see the upper value 

changed because you excluded the water bodies. You can double click to change the label of 

the <excluded> to water body. 

15. Take some time to look at the map display. Use Explore tools under Map tab on ribbon to 

see which areasof the state have higher and lower rates. You can mouse over the tool to see 

all options available. 
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Make  a  flat  map  for printing  
1.  To make a flat  map,  you need a layout  to help organize your  map.  Under  Insert  tab on the top  

ribbon,  click  New  Layout  then select  your  ideal  size  and paper  orientation to insert  a new  layout  

into your  project.  We picked a landscape letter  paper  to work  with.  

2. Now you are in the layout view. In the Insert tab from the top ribbon, click Map Frame and then 

pick the second map from CMS Approved facilities section. Your mouse will turn in to a black 

plus. Drag on your layout view to put this map down on the paper. 

3.  Similarly,  insert  a  map frame with the map of  Poverty  rate.   

4.  Click  on one of  the maps  and click  on the Format  tab on the top ribbon.  Change the Width  to  

5.3 in and Height  to 8 in.  Repeat  this  step to change the other  map  to 5.3 inches  by  8 inches.  

5. Hold shift key on your keyboard and select both maps in the layout view. Under Format tab, 

click Align and check Align to Page. Then click Align again and click on Align Middle. Then 

both of maps will be placed on the middle of the page. Use your mouse to move the map left 

and right to make use of the space well. 
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Displaying  Spatial Data Exercise  

1 

2 

6. Select one of the maps again, and under the Format tab, change the current selection from 

Map Frame to Border, and then change the Line Width to 0 pt. Repeat the same step for the 

other map. Now you’ve removed the outline of your map frames. 

7. In the Contents pane, fully expand both the Map Frame 1 and Map Frame contents so that the 
individual layers can be selected. Right click on the RI_poverty_Rate_2017 layer under Poverty 
Rate and click Zoom To Layer. Do the same thing for CMS approved facilities. Now both maps 
have been zoomed to the same scale. 
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8. Insert map elements to your project. Under Insert tab, to add a North Arrow, Scale Bar, and 

Legend with a simple click on the Map Surrounds section in the Format tab. Make sure you 

select one of the maps before inserting a legend. 

9. To modify the legend, right click on a legend and then click on Properties. Then the Format 
Legend pane will appear on the right hand side. Feel free to explore the options in this pane. 

10. To insert a title, click on Symbol button under the Insert tab in the top ribbon. Scroll all the way 

down to the bottom of the dropdown list and click on Title Large. 

11. Click anywhere on the layout where you want to place. Type in the title. 

12. Please also include a small paragraph on the bottom of the map to document the date, author, 

data source, and other relevant metadata. 
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13. After adding all desired map elements, export the map as a PDF (for printing later, for emailing, 

adding to a document). Click the Share tab on the top ribbon, select Layout. In the Export 

Layout window, navigate to where you would like to save the file and use the Save as type 
drop-down menu to select PDF (*.pdf). Keep all other options default and click Export. 

14. *Note: By default, ArcMap will export georeference information – this means that someone can 

open your PDF, and without much trouble, retrieve X/Y coordinate information for all the data in 

your map. This can be a data security issue. To disable this, uncheck the box “Export map 
georeference information” in the Export Options window when exporting. 

15. Reflect: What insights might be gained by overlaying these two data types on one map? 

For further reference see CDC’s Cartographic Guidelines for Public Health (on the Box site under 

Resources). 
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